
Release Notes8      .0Mobile Platform



 

 

DL 

 

 

 

 

 

 

 

 

 

 

RELEASE NOTES 
WEBRATIO MOBILE PLATFORM 8.0 

 



 

LEARN.WEBRATIO.COM  © WEBRATIO 8.0– 2015 

Copyright © 2015 WebRatio s.r.l–  All rights reserved. 

This document is protected by copyright and distributed under licenses restricting its 

use, copying, distribution, and decompilation. No part of this document may be 

reproduced in any form by any means without prior written authorization of WebRatio 

and its licensors, if any. 

WebRatio, the WebRatio logo, are trademarks or registered trademarks of WebRatio in 

Italy and other countries. 

DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED 

CONDITIONS, REPRESENTATIONS, AND WARRANTIES, INCLUDING ANY IMPLIED 

WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR 

NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH 

DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. 

THIS MANUAL IS DESIGNED TO SUPPORT AN INSTRUCTOR-LED TRAINING (ILT) 

COURSE AND IS INTENDED TO BE USED FOR REFERENCE PURPOSES IN 

CONJUNCTION WITH THE ILT COURSE. THE MANUAL IS NOT A STANDALONE 

TRAINING TOOL. USE OF THE MANUAL FOR SELF-STUDY WITHOUT CLASS 

ATTENDANCE IS NOT RECOMMENDED. 

Ce document est protégé par un copyright et distribuéavecdeslicences qui en 

restreignent l’utilisation, la copie, la distribution, et la décompilation. Aucunepartie de 

ce documentnepeutêtrereproduitesousaucune forme, par quelquemoyenque ce soit, 

sans l’autorisationpréalable et écrite de WebRatiosrl. 

LA DOCUMENTATION EST FOURNIE “EN L’ETAT” ET TOUTES AUTRES 

CONDITIONS, DECLARATIONS ET GARANTIES EXPRESSES OU TACITES SONT 

FORMELLEMENT EXCLUES, DANS LA MESURE AUTORISEE PAR LA LOI APPLICABLE, 

Y COMPRIS NOTAMMENT TOUTE GARANTIE IMPLICITE RELATIVE A LA QUALITE 

MARCHANDE, A L’APTITUDE A UNE UTILISATION PARTICULIERE OU A L’ABSENCE 

DE CONTREFAÇON.  

CE MANUEL DE RÉFÉRENCE DOIT ÊTRE UTILISÉ DANS LE CADRE D’UN COURS DE 

FORMATION DIRIGÉ PAR UN INSTRUCTEUR (ILT).IL NE S’AGIT PAS   D’UN OUTIL DE 

FORMATION INDÉPENDANT. NOUS VOUS DÉCONSEILLONS DE L’UTILISER DANS 

LE CADRE D’UNE AUTO-FORMATION. 

 

WebRatiosrl 

P.leCadorna, 10 – 20123 Milano ITALY 

Tel. +39 02 3671 4280 – Fax +39 02 3671 4291 

www.webratio.com – contact@webratio.com  –webratio@pec.webratio.com 



 

© WEBRATIO 8.0 – 2015 

TABLE OF CONTENTS 

Table of Contents ................................................................................................. 3 

Introduction .......................................................................................................... 5 

Features................................................................................................................ 6 

Mobile App Modeling ....................................................................................... 6 

Easily target different devices ...................................................................... 6 

Fully Functional Offline Mode ....................................................................... 6 

Up & Back Navigation ................................................................................... 7 

Toolbars ........................................................................................................ 7 

User Profiling ................................................................................................. 7 

Mobile App Basic Features ........................................................................... 7 

Integrate with existing services .................................................................... 8 

Mobile App Custom User Interface .................................................................. 9 

Mobile App Emulation on a PC ...................................................................... 10 

Mobile App Emulation on Device ................................................................... 11 

Mobile App Build and Release ....................................................................... 12 

Customize your App branding assets ............................................................ 13 

Back End Server Modeling ............................................................................. 13 

Data Services ............................................................................................... 14 

User Services ............................................................................................... 15 

Data Profiling .............................................................................................. 15 

Validation .................................................................................................... 16 

WADL .......................................................................................................... 16 

Mobile App Smart Synchronization ................................................................ 18 

Fixed in 8.0.6 ...................................................................................................... 19 

Fixed in 8.0.5 ...................................................................................................... 20 

Fixed in 8.0.4 ...................................................................................................... 22 

System Requirements......................................................................................... 25 

WebRatio Development Platform .................................................................. 25 

Operating System ....................................................................................... 25 

Java ............................................................................................................. 25 



RELEASE NOTES 

LEARN.WEBRATIO.COM  © WEBRATIO 8.0 – 2015 4 

WebRatio Generated Server Applications...................................................... 25 

Java ............................................................................................................. 25 

WebRatio Generated Mobile Applications ..................................................... 25 



5 

INTRODUCTION 

© WEBRATIO 8.0 – 2015 

INTRODUCTION 

WebRatio Mobile Platform is a powerful development environment that 
supports business users and IT developers in building mobile applications that 
can be installed on mobile phones and tablets. Your mobile applications can 
work both offline, without the use of an Internet connection, or online, 
synchronizing the information with an external system, which also can be 
developed with WebRatio Mobile Platform. 

Let’s see the main functionalities of this product release. 
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FEATURES 

Mobile App Modeling 

You can model your mobile application using the dedicated project named 
“Mobile Project”. This project uses UML notation to model the data managed 
by the application, and the IFML language to express the user interaction. See 
how easy and quick is to create your first mobile application by watching this 
lesson. Discover the main features available for your mobile app in the next 

sections. 
 
 

 
 

Easily target different devices 

WebRatio Mobile Platform lets you manage a single mobile project and deliver 
your apps to any device, such as iOS (iPhone, iPad) or Android. 

 

Fully Functional Offline Mode 
The mobile app works even without being connected to the Internet (offline 
mode). You don’t need to configure anything for this feature; WebRatio Mobile 

https://www.webratio.com/learn/learningobject/your-first-mobile-app-v-80


7 

FEATURES 

© WEBRATIO 8.0 – 2015 

Platform takes care of all the technical aspects for you. The mobile app informs 
the user that it’s working in offline mode and takes care of the data 
synchronization when necessary. 
 

Up & Back Navigation 

Consistent navigation is an essential component of the overall user experience. 
Few things frustrate users more than basic navigation that behaves in 
inconsistent and unexpected ways. For this reason, WebRatio Mobile Platform 

provides a default mechanism to handle back navigation. Of course you are also 
free to change the default behavior customizing the target of a back navigation 
directly in the model.   
 

Toolbars 

Toolbars are where the user can start different actions on the mobile 
application and access all the app content. For this reason it’s important to 
study how to organize the toolbars of your mobile app. WebRatio Mobile 
Platform gives you a dedicated modeling concept in order to model toolbars 
and to distribute the actions on the screen of the device. 

 

User Profiling 
You can model a mobile app that requires the user to register and to login with 
a valid profile in order to be able to use the application. You can create 
different user roles in you Mobile Project and give users with specific roles 
access to specific sections of the mobile application. You can also decide 
whether or not these roles are centralized in a back-end server. 
 

 
 

Mobile App Basic Features 
You can model a mobile app that allows the user to manage specific 
information by creating, updating, deleting and viewing the information, using a 
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set of predefined components. You can model lists and details, forms with 
validation rules and searches. 
 

Integrate with existing services 

Your mobile app can also use existing services if they are exposed through 
REST. You can use a dedicated component to call an external web service and 
use the result in the mobile app. 
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Mobile App Custom User Interface 

WebRatio gives you the ability to easily customize the appearance of a mobile 
application by applying a visual identity of your choice using a dedicated 
project named “Mobile Style Project”. This project uses HTML5, CSS and 
JavaScript to express the templates to be applied to the Mobile Project 
elements and to get your custom user interface. 
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Mobile App Emulation on a PC 

WebRatio gives you the chance to easily emulate a mobile application directly 
on your computer to test the feature just modeled in WebRatio Mobile 
Platform. Using the Google Chrome browser, it’s possible to navigate the 
mobile application through the Emulator embedded in the tool. Just click on 
the “Open Emulator” link provided in the opened Dashboard. 
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Mobile App Emulation on Device 

WebRatio lets you emulate a mobile application modeled with WebRatio 
Mobile Platform directly on your devices, without having to install the 
application. Just download the WebRatio Mobile Developer App from Google 
Play Store or Apple App Store, and scan the QR Code provided in the 
dashboard. In seconds, the WebRatio Mobile Developer App connects to your 
computer and you can navigate the mobile application on your device. 
 

 
 

 
 

https://play.google.com/store/apps/details?id=com.webratio.mobile.developer
https://play.google.com/store/apps/details?id=com.webratio.mobile.developer
https://itunes.apple.com/us/app/webratio-mobile-developer/id927339789
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Mobile App Build and Release 

development cycle and lets you create a build of your application in minutes. 
It’s possible to create a build for the Android or iOS platforms using our cloud 
services; you just need to configure a couple of properties. Learn how to 
configure a build and publish it on the Google Play Store or Apple App Store 
by reading the related articles on learn.webratio.com. 
 

 
 

How to Build and Publish an Application on Google Play Store 
How to Build and Publish an Application on Apple App Store 

 

  

http://learn.webratio.com/
http://www.webratio.com/learn/learningobject/how-to-build-and-publish-an-application-on-google-play-store-v-80
http://www.webratio.com/learn/learningobject/how-to-build-and-publish-an-application-on-apple-store-v-80
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Customize your App branding assets 

In order to publish a Mobile Application you have to prepare a set of assets, 
called branding assets, that belong to the *.ipa or *.apk package. 
WebRatio Mobile Platform helps you define the sets of icons and splash screens 
through the Prepare Branding Assets tool. You only have to provide one icon 
file for the Icons and one for the splash screens; the tool automatically resizes 
the images to fit all of the required sizes and resolutions. The tool then 
produces, as output, two folders containing the generated icons and splash 

screens. 
 

 

 

Back End Server Modeling 

WebRatio Mobile Platform lets you model the back-end server that stores all 
the information shown and managed by a mobile application. The back-end 
server can be modeled in a dedicated project named “Data Service Project”. 
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This project uses UML notation to define the data managed by the application. 
Then with a set of configuration steps, you can easily publish a set of RESTful 
services used by the mobile application to exchange information with the back-
end server. Learn about the main features available for your back-end server in 
the next sections. 
 

 
 

Data Services 

You can publish a Class of the back-end domain model as a RESTful resource, in 
minutes. You just have to configure a simple dialog in which you decide which 
operations are available for a specific Class: read, create, update or delete. You 
can also decide for which user role these operations are available and which are 
the exposed attributes for that Class. WebRatio Mobile Platform creates a set 

of RESTful Data Services methods reflecting your configuration. 
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User Services 

In order to be able to use the Data Services presented in the above section, the 
client user must be authorized. For this reason WebRatio Mobile Platform lets 
you configure a set of User Services that can allow a user to register, login and 
update his profile. The login is mandatory if the user needs to invoke a Data 
Service; all the other methods are optional. 
 

 
 

Data Profiling 

You can configure the Data Service of your back-end server to work only when a 
user in a specific role tries to use them. For this reason it’s possible to model, 
on the Data Service project, a set of user roles. Roles can also be used to 
restrict the amount of information visible to a user, thanks to the Restriction 
mechanism. Restrictions are conditions that can be modeled over an exposed 
class, role or method in order to state which objects are visible to the user for 

that method. 
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Validation 

Data Services, by default, do not make validation checks on the data sent by 
the mobile application. Nevertheless, you can add your own set of validation 
rules directly on the exposed Class. You can choose between different types of 

validation rules. 
 

 
 

WADL 

In addition to the REST Summary page showing the list of all available methods 
with a sample request and response, WebRatio Mobile Platform also generates 



17 

FEATURES 

© WEBRATIO 8.0 – 2015 

for all the published services the WADL (Web Application Description 
Language).  The official website http://www.w3.org/Submission/wadl/ 
 describes the WADL as follows: 
 
“An increasing number of Web-based enterprises (Google, Yahoo, Amazon, 
Flickr to name but a few) are developing HTTP-based applications that provide 
programmatic access to their internal data. Typically these applications are 
described using textual documentation that is sometimes supplemented with 
more formal specifications such as XML schema for XML-based data formats. 

WADL is designed to provide a machine process-able description of such HTTP-
based Web applications.” 
 

The URL at which you can find the generated WADL definition is composed in 
this way: 
http://<host>:<port>/<application-name>/wadl.do 
You can see in the following image an example of the generated WADL. 
 

 

  

http://www.w3.org/Submission/wadl/
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Mobile App Smart Synchronization 

WebRatio introduced a smart synchronization algorithm that allows the mobile 
application to exchange information with the back-end server optimized in the 
best way possible. Data are automatically synchronized using the configuration 
options you can configure in the “Mobile Project”. No code is needed. 
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FIXED IN 8.0.6 

 Fixed the runtime behavior for Mobile Application when emptying a date 
field. 

 Date fields now show the datepicker on Android 4.2 devices. 

 In the App View of Mobile Project it is now possible to add a Screen or a 
ScreenSet by using the contextual menu in the work area. 

 Fixed an issue that now prevents in a Mobile Project to model more then 
one back event from a Screen to another one. 

 Fixed the behavior of logout service for Mobile Applications running on 
Android devices. The "Access denied: please login again" message is no 
longer displayed after restarting the Mobile App. 

 In a Mobile Project it's now possible to model selection fields using any 
data type. 

 The preloaded field values of a Mobile Application Form are now 

preserved after the periodical background synchronization completes. 

 Fields of a Mobile Application Form are no longer reset after the screen 
refresh. 

 Selection Fields having the Split Output property enabled now work 
properly in the Mobile Application when submitting, even if not filled. 

 A Generation Error is now properly returned when generating a Mobile 
Project having an Attribute of a Class mapped to a non-existing Server 
Attribute in the associated DataService Project. 

 Solved an issue that may have caused the startup synchronization to be 
slow. The performance of the startup synchronization has thus been 
improved. 
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FIXED IN 8.0.5 

 Validation rules on BLOB are now properly working at runtime. Changed 
the code for writing BLOB fields in the default templates from <div 

wr-blob="view.form.[%= field["id"] %]"> to <div ng-
model="view.form.[%= field["id"] %]" wr-form-property 

wr-blob>.  Custom templates also need to be updated. 

 The back-end database connection is now released in case of failed 

authentication of the login. Added the 
log4j.logger.com.mchange.v2=TRACE, RTXLogFile log 
configuration to check the connection pool usage at runtime. 

 It's now possible to use Google Maps. Added "geo" and 
"google.navigation" URL protocols to those considered "safe" by the 
Mobile App Runtime. 

 Date and Time fields belonging to Form Component in a Mobile Project 
can now be preloaded with string values. 

 The "Search Reference" command available in the contextual menu of a 
Class is now properly working. 

 Items belonging to DataService Projects shared in CVS Repositories are 
now properly decorated when shown in the Synchronize perspective. 

 The WebRatio Compare Editor available in the Team Synchronizing 
perspective now opens up properly when selecting a conflicting screen 
of the Mobile Project. 

 Changed the layout for dialogs displayed by the Mobile Application in 

case of errors. Now the dialog contains an OK button that closes it. 

These dialogs are shown when, in a Mobile Project, you bind something 
with the Notification Message of an Error Port Definition. 

 Fixed an issue that caused the mobile application to hang when an 
explicit "Error" dialog is displayed and not yet closed by the user. 

 In a Mobile Project, double-clicking on a Screen now opens its Layout 
tab. 

 The back-end "Update" services now always include the file id in the 
response when a new file is uploaded. 

 The "Update" command available in the contextual menu on items 
shown in the Compare Editor for Screen of Mobile Projects now correctly 
imports the change in the local model. 
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 DataService Projects are now properly shown in the WebRatio Explorer 
View when the "Show Working Set" toggle is enabled. 

 The back-end runtime has been improved in order to avoid the wrong 
update of information belonging to database views, which cannot be 
changed. 

 The generated Mobile Application can be now properly emulated on 
Linux environments. 

 In the WebRatio Explorer View, the items referring to the Mobile or 
DataService Project model element are now properly decorated when 
the "Show Model Folder" toggle is enabled. 

 Fixed a problem preventing the WebRatio Platform from startup on Linux 
environments. 

 Fixed the behavior for the "Layout.xml" file editing in Mobile Style 
Projects. There's no more need to reload the file after saving the file. 

 The Calendar Component available for the Mobile Project now also 
works using string values as input for the current date, year and month. 

 Fixed the issue regarding the behavior at runtime of View Components in 
Mobile Projects having the "App User" class as Data Binding property. 

 Double-clicking on the "Missing Home Element" Generation Error in 
Mobile Project now opens the Project tab. 

 The selection of an element in the Outline View of a Mobile Project now 
always highlights the corresponding model element in the work area. 

 The Top Bar Location shown in the Layout View of a Screen in a Mobile 

Project now opens up properly when selected. 
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FIXED IN 8.0.4 

 In WebRatio Mobile Platform Community Edition you can now see the 
correct license expiration date in the "License Information" dialog. Go to 
the "Help" menu and choose the "License Information" option. 

 Fixed the behavior for WebRatio Mobile Platform startup in case of an 
expired license. A warning dialog is now shown to inform the user about 
the expired license. 

 The back-end runtime has been improved in order to update the 
information in the database by accepting, for the delta parameter 
timestamp values, milliseconds and time zone (e.g. 

"20150126T14:03:46.000" ). 

 Fixed the behavior for List Component in Mobile Projects containing 
Conditional Expressions having the "empty" value as "Default Policy" 
property and having for each condition the "True" value for the 
"Required" property. 

 Fixed the generation process behavior regarding the "Ignore Case" 
property of an Attribute Condition added on a List Component in Mobile 
Projects. This property is now ignored when not supported by the 
associated Predicate (i.e., "Is Null", "Greater Than", ...). 

 Fixed the rendering for Selection Fields belonging to a Form Component 
in Mobile Projects. If the Selection Field contains a Slot having only the 
"Label" property activated, it is now properly rendered at runtime. 

 Improved the logged information for non-checkable List Components 
placed in Screens of Mobile Projects. If the List Component has the 

"Checkable" property disabled, an empty array is logged in the emulator 
console about the corresponding "checkedRows" for the List Service. 

 A proper warning dialog is now displayed when the user tries to 
download any item from WebRatio Add-Ons using a WebRatio Mobile 
Platform edition with an inactivated license. 

 Conditional Expressions having the "Fill" value as "Default Policy" 
property for the List Component now work properly in Mobile 
Applications. 

 Fixed the runtime behavior regarding Create Operations in Mobile 

Projects marked as bulk when receiving as input arrays and simple values 
(or 1-element arrays) at the same time. Now in a Class, many instances 
are created as the length of the array with the simple value associated 
with each element of the array. 
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 The validation rules on fields of a mobile application form are now 
performed only when the "Enable Validation" property is enabled on the 
On Select Event placed on the correspondent Form Component in the 
Mobile Project. 

 Attribute Conditions added on the View Components (such as List 
Component, Details Component) in Mobile Projects now work properly 
on Date, Time and Timestamp attributes. 

 The Attribute Conditional Expression Parts of List Component in Mobile 

Project now support a series of constant values in the Value property. 
The constant values must be separated by single pipe (|) characters. 

 Fixed the runtime behavior for Fields belonging to the Form Component 

in Mobile Projects having the "url" value for the "Type" property. Now 
the entered value for url fields is properly saved even if the url doesn’t 
begin with the "http://" prefix. 

 Fixed the generation of a Mobile Project containing a View Component 
(i.e., List, Detail, ...) having a Conditional Expression with no conditions 
defined. 

 Fixed the runtime behavior for Detail Components in Mobile Projects 
that do not have the "Display Attributes" property set. In this case, an 
empty Detail Component is now displayed. 

 A warning is now reported if an element in the Mobile Project is 
protected and there are roles defined in the Mobile Project when you run 
the "Find Model Problems" command. It's mandatory to select at least 
one role for that element. 

 Fixed the behavior for copying and pasting the "Login" Action 

Definitions in Mobile Projects. Now if you copy the "Login" Action 
Definition from a Mobile Project and paste it into another one, the 
"Login Definition" flag property is preserved. 

 There is now a dedicated dialog where you can see the default errors 
and warning messages that can be reported for the WebRatio Mobile 
Platform version. To see this dialog, go to the "Window" menu -> 
"Preferences" and in the opening dialog expand the "WebRatio" node 
and the "Error/Warnings" node. At the end, select the "Mobile" option. 

 Fixed the behavior for cutting and pasting Screens in Mobile Projects. 

Now if you cut the Home Screen from a ScreenSet and paste it into 
another one, the "Home" flag property is preserved. 
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 In Mobile Project, it's now possible to bind arrays of a constant (i.e., 
element separated by pipe) as input to View Component Conditions such 
as List or Details Component. 
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SYSTEM REQUIREMENTS 

WebRatio Development Platform 

Operating System 

 Microsoft Windows Vista or higher, 64 bit 

 Linux, 64 bit 

 Mac OSX 10.7 (Lion) or higher, 64 bit 

Installing WebRatio Development Platform also requires: 
 

 Disk Space: 600 MB 

 RAM: 4 GB minimum, suggested is 8 GB 

Java 

When running WebRatio Development Platform on a computer you will need 
the Java Runtime Environment (JRE) 1.7 or higher. 

You can download JDKs here: 
http://www.oracle.com/technetwork/java/javase/downloads/index.html 

WebRatio Generated Server Applications 

Application Server 
 
When running WebRatio Generated Server Applications on a server you will 
need a Java Application Server compatible with Servlet 3.0 and JSP 2.2. 
 

Java 

When running WebRatio Generated Server Applications on a server you will 
need the Java Runtime Environment (JRE) 1.6 or higher. 
 
You can download JDKs here: 
http://www.oracle.com/technetwork/java/javase/downloads/index.html 

WebRatio Generated Mobile Applications 

The Mobile Apps generated with WebRatio Mobile Platform are compatible 

with: 
 Android 4.0.3 or higher 

 iOS 7 or higher 

http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://www.oracle.com/technetwork/java/javase/downloads/index.html
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